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Part A: Comparison with FIML in the case of normal data.
Stephen du Toit

Multivariate data sets, where missing values occur on more than one variable, are often
encountered in practice. Listwise deletion may result in discarding a large proportion of the
data, which in turn, tends to introduce bias.
Researchers frequently use ad hoc methods of imputation to obtain a complete data set.
The multiple imputation procedure implemented in LISREL 8.7 is described in detail in
Schafer (1997) and uses the EM algorithm and the method of generating random draws
from probability distributions via Markov chains (MCMC algorithm). Technical details of
these methods are given in the Interactive LISREL: User’s Guide, pages 387-388. Also see
pages 165-170 of the same guide for an example.
For approximately normally distributed data, with values missing at random, the optimal
strategy for fitting structural equation models is to use a full information normal maximum
likelihood (FIML) procedure such as the one implemented in LISREL8.7. FIML is illustrated
with the set of examples in the missingex folder of the LISREL8.7 installation. Part A
illustrates this point by showing how one can fit a series of SEM models based on imputed
datasets. The means of the estimated parameters thus obtained are subsequently
compared with the estimated parameters obtained using FIML.
In Part B, Gerhard Mels investigates the non-normal case and compares robust maximum
likelihood (RML) with FIML.
The data set grant.dat (simulated data) is based on a real data set containing nine
psychological tests administered to seventh- and eighth-grade students (see page 140 of
the LISREL User’s Guide). Only the first 6 variables VISPERC, CUBES, LOZENGES,
PARAGRAF, SENTENC and WORDMEAN are considered here. The first three variables
are assumed to measure spatial perception and variables four to six verbal perception.
From the main menu bar, select the File, Import Data in Free Format option.
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Select the file grant.dat from the missingex folder. Once selected, click Open to activate
the Enter Number of Variables dialog box. Enter 6 in the Number string field.
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Click OK to obtain the PRELIS system file grant.psf. Note that default variable names,
VAR1, VAR2, …, VAR6 are assigned. To assign the value –9.0 as the global missing value
code, select Define Variables from the Data menu. Click on any variable to highlight it and
then on the Missing Values button (see pages 147-148 of the Interactive Guide for a
detailed description). Enter –9.0, change the method of deletion to Pairwise and click OK
when done.

To change the variable type from the default of ordinal to continuous, select the variable
VAR1 and click on Variable Type on the Define Variables dialog box to go to the Variable
Types dialog box. Check the Continuous radio button and the Apply to all check box.
Then click OK to return to the Define Variables dialog box. On this dialog box, also click
OK. Use the File, Save option to ensure that the changes made are saved to grant.psf.
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From the Statistics menu, select the Multiple Imputation option.

Select all the variables from the Variable List:. Note that if no variables are selected,
PRELIS assumes that all the variables in the data set are to be used.
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To impute data using the EM algorithm, click the EM Algorithm radio button. To save the
imputed data to an external file, click the Output Options button to open the Output dialog
box. Enter the values as shown below and click OK when done to return to the Multiple
Imputation dialog box.
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Click the Run button to do the multiple imputations and to obtain the data set
grant_em.dat. Note from the PRELIS output that this file contains 4996 observations, as
four of the original 5000 observations contained missing values on all 6 variables.
Next, we would like to impute 10 data sets based on grant.psf using the MCMC option. To
do so, select the Multiple Imputation option from the Statistics menu.

Check the MCMC radio button and click Output Options to activate the Output dialog box.
Enter values as shown below. Note that for this example, the number of repetitions equals
10. Also note that the data set grant_mcmc.dat will contain 10 x 4996 = 49960
observations. To use an alternative random seed, activate the Set seed to radio button and
enter a number, for example, 76381.
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Click OK to return to the Multiple Imputation dialog box. If the Syntax button is clicked,
the PRELIS syntax file shown below is generated.

Two parts of the output file are shown below. We see that the percentage of missing values
equals 31.97%.
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Note that the PRELIS analyses are based on all the observations in the imputed data set.
The sample means are relatively close to the estimated means.

To obtain summary statistics for each individual dataset, one can use the following PRELIS
syntax file.
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Note that it is also possible to save any of the summary statistics, for example the means
and standard deviations, to external files. The keyword XO=n on the OU line restricts the
output to the first n datasets. The files grant.mea and grant.std, however, contains the
means and standard deviations of all the datasets.
Next, we wish to copy the file missex2a.ls8 to grant_mcmc.ls8. Open the file
missex2a.ls8 located in the missingex folder. Then use the File, Save As.. option to
invoke the Save As dialog box.

Save as grant_mcmc.ls8 as shown below. Click the Save button when done.

Modify grant_mcmc.ls8 as shown below. Note that RP = 10 is used on the DA line (MI = 9 is deleted). We have also added PV = grant_mcmcm.fit and SV = grant_mcmc.std to the
OU line. Note that the sample size (NO = 4996) must be specified when the RP keyword is
used. Click the LISREL Run button to fit 10 successive models to the data. The first model
reads lines 1 to 4996 from the data file, the next model reads lines 4997 to 9992 and so on.
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Contents of grant_mcmc.fit are shown below. The first line contains the repetition number
followed by two zeros indicating no convergence problems were encountered. The values
are followed by the 13 estimated free parameters.

To obtain the means of the estimates, select the Import Data in Free Format option from
the File menu, locate grant_mcmc.fit, and enter the number of variables as shown below.

Delete the first three variables from the PSF file as shown below.
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Use the Data, Define Variables option to change the variable type from ordinal to
continuous. Save the modified PSF file and then select the Data Screening option from the
Statistics menu to obtain the following PRELIS output.

The means reported above are in the same order as in the printout of the estimated
parameters. One can obtain the so-called FIML estimates of the free parameters by
running the example missex2a.ls8. These values can subsequently be compared to the
means listed above.
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Part B: Comparison with FIML in the case of arbitrary data.
Gerhard Mels

1. Introduction
Many of the statistical methods, which are available within LISREL 8.7 for Windows
(Jöreskog & Sörbom 2002), assume that the data follow a multivariate Normal distribution.
These methods include, amongst others, Multiple Imputation and Full Information Maximum
Likelihood (FIML) estimation for missing data. Very little is known about the robustness
(sensitivity) of these two methods to violations of the assumption of multivariate Normal
data.
In this note, a Confirmatory Factor Analysis (CFA) model and a non-Normal data set are
used to illustrate how LISREL 8.7 for Windows may be used to investigate the robustness
of Full Information Maximum Likelihood estimation for missing data. In particular, the FIML
results are compared with the average Robust Maximum Likelihood (RML) results obtained
for 100 imputed data sets.
The data set is described in the next section. Thereafter, the CFA model to be used is
described. Section 4 illustrates the use of FIML estimation for missing data to fit the CFA
model to the non-Normal data set. In Section 5, the generation of the 100 imputed data
sets is illustrated first after which the CFA model is fitted to the 100 imputed data sets. The
FIML and robust RML results are compared in Section 6.

2. The Data
The data set to be used is one of 1000 random samples that were generated from a
multivariate non-Normal distribution with a specific population correlation matrix. This nonNormal distribution is a multivariate distribution for which the skewnesses and kurtoses of
the marginal distributions are all equal to 1.95 and 30 respectively. In the case of the
multivariate Normal distribution, these marginal skewnesses and kurtoses are all equal to
zero. More details on the simulation study are available in Mels (2000). The Prelis system
file ARDATA0.PSF contains the original data set. Missing values were inserted at random
to enable the application of Multiple Imputation and FIML estimation for missing data. The
resulting data set has 15.35% missing values. A value of –9.000 is used to indicate the
missing values. A small section of the resulting data set is shown in the PSF window in
Figure 1.

3. The CFA Model
The model, from which multivariate non-Normal data were simulated, is a Confirmatory
Factor Analysis (CFA) model that specifies 12 indicators for 3 correlated factors (latent
variables). A path diagram of the CFA model is shown in Figure 2. The model, depicted in
Figure 2, has 27 unknown parameters (12 factor loadings, 3 factor correlations and 12
measurement error variances).
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Figure 1: The PSF Window for Non-Normal Data with Missing Values

Figure 2: The CFA model for the FIML and RML Comparison
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4. FIML Estimation for Missing Data
We will use a path diagram (PTH file) to fit the model in Figure 2 to the Non-Normal data in
Figure 1 by means of FIML estimation. We start out by creating an empty path diagram
that only contains the variables of the model. This is achieved by using the SIMPLIS
syntax file ARDATA0.SPL that is shown in the following text editor window.

The first line of the syntax file above specifies the data source to be used.
Lines 2-3 specify labels for the latent variables of the CFA model.
Line 4 requests a path diagram (PTH file).
The final line indicates the end of the commands to be processed.
Click on the Run LISREL toolbar icon

to produce the following path diagram window.

Activate the Arrow icon on the Draw toolbar.
Use your mouse to click and drag 4 indicator paths from the latent variable FACTOR1 to
ITEM1 to ITEM4.
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Use your mouse to click and drag 4 indicator paths from the latent variable FACTOR2 to
ITEM5 to ITEM8.
Use your mouse to click and drag 4 indicator paths from the latent variable FACTOR3 to
ITEM9 to ITEM12.
Activate the Double-headed Arrow icon on the Draw toolbar.
Use your mouse to click and drag 3 covariance paths between the three latent variables
FACTOR1, FACTOR2 and FACTOR3 to produce the following path diagram window.

Select the Build LISREL Syntax option from the Setup menu to generate the following
Lisrel ProJect (LPJ) window.
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Click on the Run LISREL toolbar icon

to produce the following path diagram window.

The results above are the FIML estimates of the parameters of the CFA model in Figure 2.
The FIML standard error estimates and measures of fit are provided in the output file
ARDATA0.OUT.

5. RML Estimation for Imputed Data Sets
The following actions may be used to generate 100 Markov Chain Monte Carlo (MCMC)
imputed data sets from the raw data in ARDATA.PSF.
Use the Open option on the File menu of the root window to open ARDATA.PSF.
Select the Multiple Imputation option on the Statistics menu of the PSF window to load
the Multiple Imputation dialog box.
Highlight all the labels in the Variable List: list box.
Click on the Select push button to transfer the selected labels to the Select Variables: list
box.
Activate the MCMC radio button.
Click on the Output Options push button to load the Output dialog box.
Check the Save to file: checkbox in the Save transformed data to file: section.
Enter the name ARDATA_MCMC.DAT in the string field in the Save transformed data to
file: section.
Enter 100 in the Number of Repetitions string field.
Click on the OK push button to return to the Multiple Imputation dialog box.
Click on the Run push button to produce the following output file window.
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To fit the CFA model in Figure 2 to the 100 MCMC imputed data sets in
ARDATA_MCMC.DAT by means of RML, the 100 corresponding sample covariance
matrices and estimated asymptotic covariance matrices of the sample variances and
covariances are required. These matrices may be obtained by using the PRELIS syntax
file ARDATA2.PR2 that is shown in the following text editor window.

The DA command line specifies that each one of the 100 MCMC data sets (RP=100)
contains 500 cases (NO=500) of 12 variables (NI=12).
Lines 2-4 specify labels for the 12 observed variables in each MCMC imputed data set.
The RA command line specifies the raw data source.
Line 6 specifies that all 12 variables are continuous.
The OU command line specifies that the sample covariance matrices should be computed
(MA=CM) and saved to the file ARDATA_MCMC.COV (CM=ARDATA_MCMC.COV). It
also specifies that the 100 estimated asymptotic covariance matrices should be computed
and saved to the file ARDATA_MCMC.ACM (CM=ARDATA_MCMC.ACM).
Click on the Run Prelis toolbar icon to generate the output file window for ARDATA2.OUT.
Use the Open option on the File menu to open the LPJ file ARDATA0.LPJ.
Use the Save As option on the File menu to save the file as ARDATA1.LS8.
Add the option RP=100 to the DA command line.
Replace the command line
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RA FI='C:\lisrel852\Workshop_August_02\ARDATA.PSF'
with the following command lines
CM=ARDATA_MCMC.COV
AC=ARDATA_MCMC.ACM
Add the options PV=ARDATA_MCMC.PV (saving all the parameter estimates to the file
ARDATA_MCMC.PV), SV=ARDATA_MCMC.SV (saving all the standard error estimates to
the file ARDATA_MCMC.SV) and GF=ARDATA_MCMC.GF (saving all the measures of fit
to the file ARDATA_MCMC.GF) to the OU command line.
Add the option XO=2 to the OU command line to restrict the output file to the results for the
first two data sets only.
The resulting LISREL syntax file is shown in the following text editor window.

Click on the Run LISREL toolbar icon
ARDATA0.OUT.

to produce the output file window for

6. Comparison of FIML and RML Results
The PRELIS syntax file ARDATA3.PR2, which is shown in Figure 3, may be used to obtain
the average RML parameter and standard error estimates as well as mean RML measures
of fit for the parameters of the CFA model in Figure 2 for the 100 MCMC imputed data sets.

18

Figure 3: A Prelis Syntax File to obtain Mean RML Results

Click on the Run Prelis toolbar icon to generate the output file window for ARDATA3.OUT.

The FIML and the mean RML parameter and standard error estimates are summarized in
Table 1, while selected FIML and mean RML measures of fit are summarized in Table 2.

The results in Tables 1 and 2 indicate that there are discrepancies between the FIML and
RML results. However, there are very few substantial differences. Furthermore, there is no
clear pattern in these discrepancies. An extensive Monte Carlo study is required to assess
the performances of these two statistical methods.
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Table 1: FIML and Mean RML Parameter and Standard Error Estimates
Parameter
LX (1,1)
LX (2,1)
LX (3,1)
LX (4,1)
LX (5,2)
LX (6,2)
LX (7,2)
LX (8,2)
LX (9,3)
LX (10,3)
LX (11,3)
LX (11,3)
PH (1,2)
PH (1,3)
PH (2,3)
TD (1,1)
TD (2,2)
TD (3,3)
TD (4,4)
TD (5,5)
TD (6,6)
TD (7,7)
TD (8,8)
TD (9,9)
TD (10,10)
TD (11,11)
TD (12,12)

FIML
Estimate
0.586
0.654
0.765
0.810
0.593
0.922
0.774
0.812
0.525
0.717
0.609
0.747
0.360
0.305
0.589
0.209
0.289
0.229
0.393
0.553
0.444
0.474
0.281
0.423
0.263
0.372
0.280

Mean RML
Estimate
0.591
0.655
0.760
0.812
0.596
0.910
0.787
0.781
0.525
0.728
0.586
0.748
0.369
0.312
0.625
0.190
0.265
0.209
0.355
0.506
0.432
0.422
0.284
0.392
0.255
0.354
0.255

FIML Std.
Mean RML Std.
Error Estimate Error Estimate
0.032
0.028
0.036
0.040
0.037
0.027
0.044
0.046
0.045
0.058
0.048
0.118
0.045
0.069
0.041
0.055
0.039
0.037
0.038
0.041
0.039
0.037
0.039
0.040
0.047
0.058
0.049
0.051
0.039
0.054
0.020
0.021
0.026
0.032
0.027
0.031
0.038
0.087
0.043
0.095
0.047
0.093
0.042
0.063
0.033
0.036
0.033
0.060
0.029
0.070
0.032
0.037
0.032
0.060

Table 2: Selected FIML and Mean RML Measures of Fit
Measure
Chi-Square Test Statistic Value
RMSEA Point Estimate
Lower Limit of 90% CI for RMSEA
Upper Limit of 90% CI for RMSEA

FIML Value
120.899
0.052
0.040
0.065

Mean RML Value
138.970
0.059
0.047
0.071
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